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Getting Started

About this Manual
This manual is designed to provide you with the basic 
information you need to install, configure and use TEKLYNX 
CENTRAL.

Typographic 
Conventions

This manual uses the following conventions to distinguish 
between different types of information:

• Terms taken from the interface itself, such as menu 
names, commands and button names appear in bold.

• Keys appear in uppercase, as in the following example:

“Press the SHIFT key.”

• Numbered lists indicate a procedure to follow.

• The sequence for selecting a command from a menu will 
be described, but a button is also available for many 
functions.

• Angle brackets <> indicate system setup information that 
must be entered by keyboard. Enter only the information, 
not the brackets.

Product Components 
Your software is packaged with the following components:

• DVD

• This documentation

e
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System and Server Requirements

Other Documentation Resources

Product CD In addition to any printed documentation that may be included 
with your product, you can find all available TEKLYNX CENTRAL 
documentation in PDF format on the product DVD. The PDF 
documents can be viewed in Adobe Acrobat Reader and 
printed for easy reference.

To access the TEKLYNX CENTRAL documentation on the DVD, 

Processor Minimum:
2 GHz or faster

Operating
System

• Windows Server 2003 x32/x64 (including R2 edition)

• Windows Server 2008 R2 x64

Memory 1 GB of free RAM

Hard Disk 
Space

Minimum 1.5 GB of free disk space

Supporting 
Software

On the server:
Microsoft Internet Information Services (IIS) 6.0 or 7.0
Microsoft SQL Server 2005 or later
.NET Framework 3.5 SP1
ASP .NET 2.0

On the print client:
Microsoft Internet Explorer 7 or later

On the label designer client:
Microsoft Internet Explorer 6.0 SP1 or later
.NET Framework 3.5 SP1
Microsoft Data Access Components (MDAC) 2.8 or later
Adobe Acrobat Reader 6.0 or later

Video Card DirectX 9.0 minimum

Additional 
Requirements Administrator rights to the computer used during installation
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click the Installation Guide button available on the DVD’s 
opening screen.

You can also download product documentation at 
www.teklynx.com.

Other Product 
Documentation

Supplementary manuals for CODESOFT, LABEL ARCHIVE, 
LABELNET, and SENTINEL are also included on the DVD. For 
more detailed instructions on these products, refer to the 
corresponding product documentation.

User and administration manuals for these applications are 
also available online at www.teklynx.com.
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Installation

Welcome!
Thank you for purchasing TEKLYNX CENTRAL. This installation
guide contains information on how to install and configure
TEKLYNX CENTRAL, in addition to using the Command Center
to interact with CODESOFT, LABEL ARCHIVE, LABELNET, and
SENTINEL.

About TEKLYNX CENTRAL
TEKLYNX CENTRAL manages enterprise labeling users,
licenses, and installation within one interface. The Command
Center coordinates TEKLYNX’ proven label design, printing,
security, and tracing applications to simplify administration. 

TEKLYNX CENTRAL offers the following features:

Label Design Security and Traceability – You can create all
of your label templates in the label designer and secure them
in the label database. All modifications and print requests are
tracked in the database to provide an audit trail of print and
label history.

Browser-Based Printing Interface – The browser-based
printing interface uses a unique data input model that allows
you to eliminate unnecessary user steps by limiting access to
labels at the work order, workstation, and printer level. In
addition, the configurable interface allows you to use
terminology specific to your business environment, which
reduces training time for new users.

e
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Label Printing – Print requests that are sent from a host
system or the browser-based user interface are processed and
sent to networked printers.

Installing TEKLYNX CENTRAL
1 Insert the DVD, click TEKLYNX CENTRAL Installation, 

and then click the Install icon. If the DVD does not 
automatically launch, use the Windows Run command to 
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type the letter of the DVD drive followed by index.hta 
(for example, D:\index.hta) and press ENTER.

The TEKLYNX CENTRAL Installer opens.

Figure 2-1 TEKLYNX CENTRAL Installer

2 Click Start. If a required Windows application is missing 
on your system, the installation program will prompt you 
to install the prerequisite file.
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Figure 2-2 Required Windows Prerequisite

Click Install to install any required prerequisites. 

Installation of Windows prerequisites may require a 
system reboot to complete the installation. If a system 
reboot is required, a message will appear prompting you 
to restart your computer. Click Yes to restart your 
computer.

3 If all required Windows prerequisites are already installed, 
or after the installation of any necessary prerequisites has 
finished, the TEKLYNX CENTRAL Installation Wizard 
appears.
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Figure 2-3 TEKLYNX CENTRAL Installation Wizard

4 Click Next. 
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The License Agreement window appears.

Figure 2-4 License Agreement window

5 Read the license agreement. If you agree with the terms 
of the license agreement, select I accept the terms of 
the license agreement and click Next. 
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The Customer Information window appears.

Figure 2-5 Customer Information window

6 Enter your name and the name of your company and click 
Next.
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The Destination Folder window appears.

Figure 2-6 Destination Folder window

7 The default installation folder is C:\Program Files\Teklynx. 
If you would like to change the installation folder, click 
Change and browse to the desired location. Click Next.



Installation Chapter 2-9

The Web Site Selection window appears.

Figure 2-7 Web Site Selection window

8 From the drop-down list, select the IIS web site. The IIS 
web site is the site from which the TEKLYNX CENTRAL 
browser-based printing interface will launch on client 
workstations. Click Next. 
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The Virtual Directory window appears.

Figure 2-8 Virtual Directory window

9 Specify the virtual directory name for the TEKLYNX 
CENTRAL browser-based printing interface. The virtual 
directory is part of the path that displays in the browser 
address bar when a user launches the printing interface. 
Click Next. 
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The Database Type window appears.

Figure 2-9 Database Type window

10 Choose the database type that will be used. Click Next.
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• If Microsoft SQL Server was selected, the Database 
Server window appears. 

Figure 2-10 Database Server window

From the drop-down list, select the SQL database 
server. This is the server that stores your configuration 
data (including label data and the relationships 
between items and labels).

Note: SQL configurations with “named instances” 
require special installation. During TEKLYNX CENTRAL 
installation, the wizard may display several possible 
database servers; for example, (Local)/DB instance 
name or (Workstation name)/DB instance name. 
You must select an item that contains a workstation 
name to ensure a correct connection. Click Next.
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• If Oracle was selected, the Datasource window 
appears.

Figure 2-11 Datasource window

Enter the database that will be used for the LABEL 
ARCHIVE Server, UMSS\MSGS, and TEKLYNX CENTRAL 
instances, along with the relevant user credentials. 
This is the server that stores your configuration data 
(including label data and the relationships between 
items and labels). Click Next.

Note: Oracle database support is only available in 
32-bit operating systems. The Microsoft Server 2003 
R2 32-bit operating system is not supported.
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11 You are ready to install TEKLYNX CENTRAL.

Figure 2-12 Ready to Install window

12 Click Install to begin installing TEKLYNX CENTRAL. The 
installation wizard will indicate when installation is 
complete.

13 Click Finish to exit the wizard.

14 When installation is complete, click Close to exit the 
TEKLYNX CENTRAL Installer.
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Using the Command Center

Once TEKLYNX CENTRAL has been installed, it can be used to
administer all components of your enterprise labeling solution.

The Command Center
The TEKLYNX CENTRAL Command Center provides access to
all components of your enterprise labeling software. 

Figure 3-1 TEKLYNX CENTRAL Command Center

Use the default user to log into TEKLYNX CENTRAL for the first
time. The username for this account is administrator and the
password is admin.

e
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Managing Software Maintenance Agreements
A TEKLYNX Software Maintenance Agreement (SMA) gives you
access to the latest software updates and training manuals for
your registered TEKLYNX products. Entering your SMA number
into the Command Center gives you quick access to your
registration and expiration information. The system will also
remind you when your SMA contract is up for renewal.

Entering SMA 
Information

To enter your SMA number in TEKLYNX CENTRAL:

1 Click the Enter SMA Number link in the Software 
Maintenance Agreement (SMA) section. The SMA window 
opens.

Figure 3-2 SMA window

2 Type your SMA number in the Enter SMA Number field.

3 Click OK.

TEKLYNX CENTRAL will query the TEKLYNX SMA Center to 
locate the expiration date of your maintenance 
agreement. If your system does not have an Internet 
connection, an error message will appear.
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Managing Licenses
The Licenses section of the Command Center allows you to
manage user licenses and roles.

Adding/
Configuring User 
Rights

To add or configure user rights:

1 Click the Manage Users link in the Licenses section. 

The UMSS-MSGS window opens.

Figure 3-3 UMSS-MSGS window

2 In the file tree on the left, go to UMSS-MSGS Servers > 
UMSS > Users, and right-click to select New > User. 
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The User Properties - New window opens.

Figure 3-4 User Properties - New window

3 On the User tab, enter the user’s first and last name in the 
appropriate fields.

Then, if: 

• Using UMSS authentication, enter a user name and 
password, and confirm the password.

• Using Active Directory, select Windows from the 
Authentication drop-down list and click the Browse 
button to locate the appropriate user.

4 On the Group Memberships tab, select the user groups 
that the user should belong to.

The following user groups can be used:

• Administrators – This user group is used by the 
installed components of TEKLYNX CENTRAL and 
provides initial access to the application to set up other 
users. You must have at least one user in this user 
group. This user can then create the TEKLYNX 
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CENTRAL Administrator in user group ACAdministrator.

• PrintUsers – This user group should not be used. 
TEKLYNX CENTRAL print users should be added to the 
ACPrintUser group.

• ACAdministrator – These administrators can connect 
to the TEKLYNX CENTRAL Command Center, design 
labels, approve labels, print labels, and create reports.

• ACDesignUsers – Designers have the ability to design 
labels and approve labels.

• ACPrintUsers – Print users have the ability to print 
from the web printing interface.

• ACReportUsers – Report users have the ability to 
generate audit and print history reports.

Figure 3-5 User Properties - Group Memberships tab

5 Click OK to save your user and group settings.

Viewing 
Connected Users

To view connected users:

1 Click the View Connected Users link. 



Chapter 3-6 Installation Guide

The Users window appears.

Figure 3-6 Users window

2 Expand each user group to display the connected users.

Adding Licenses To activate or add licenses:

1 Click Add Licenses. The License Activation window 
appears.

Figure 3-7 License Activation window

2 Click Browse and locate the License_upgrade.exe file.

3 Follow the instructions displayed in the wizard to activate 
or add a TEKLYNX CENTRAL license.
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Using the Label Designer
The Label Designer section of the Command Center provides
links to launch the label designer application, where you can
design and test print labels.

The label designer is powered by CODESOFT. For more
information on designing and test printing labels, refer to the
CODESOFT 9 User Guide. For more information on checking
labels in and out of the label database, refer to the LABEL
ARCHIVE User Guide.

To launch the label designer, click the Design and Test
Labels link in the Label Designer section.

Using the Label Manager
The Label Manager section of the Command Center provides
links to manage labels and define approval rules.

Note: When a new version of a label is checked into LABEL
ARCHIVE, the printing interface will automatically use this
version for any subsequent print requests.

The TEKLYNX CENTRAL label manager is powered by LABEL
ARCHIVE. For more information on managing labels, refer to
the LABEL ARCHIVE Administrator’s Guide and LABEL
ARCHIVE User Guide.

Managing Labels 1 Click the Delete, Archive, or Reset Labels link in the 
Label Manager section. This will launch the LABEL 
ARCHIVE Server application.

2 To delete labels:

a In the LABEL ARCHIVE Server application, select 
Console Root > LABEL ARCHIVE Server 
Administration > Tasks > Delete documents and 
data from the Console Root tree in the left pane.

b On the Filter tab, choose the categories and types of 
labels to search for.

c On the Documents tab, choose the labels to delete and 
click Delete.

Note: This action will permanently delete labels from the 
label database.
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3 To archive labels:

a In the LABEL ARCHIVE Server application, select 
Console Root > LABEL ARCHIVE Server 
Administration > Tasks > Archiving from the 
Console Root tree in the left pane.

b On the Filter tab, choose the categories and types of 
labels to search for.

c On the Documents tab, choose the labels to archive.

d On the Archive Options tab, browse to the folder where 
the archived database will be stored. Enter a name for 
the backup file and click Save.

If you want to delete the label(s) from the label 
database, select Delete after archive and click 
Archive.

4 To reset the label’s check out state:

a In the LABEL ARCHIVE Server application, select 
Console Root > LABEL ARCHIVE Server 
Administration > Tasks > Reset documents > 
Checkout state from the Console Root tree in the left 
pane.

b Select the desired label and click Reset.

Managing 
Approval Rules

1 Click Configure Approval Rules. The LABEL ARCHIVE 
Client application will launch.

2 In the LABEL ARCHIVE Client application, select Console 
Root > LABEL ARCHIVE Client Administration > 
Approval rules from the Console Root tree in the left 
pane.

3 To create a new approval rule, click New.

4 Enter a name for the new rule in the Name field.

5 Select when the step should be processed in the State 
drop-down list.

6 Select whether the step applies to a single user or a user 
group in the Handler drop-down list.

7 Select the user or user group in the Parameter 
drop-down list.

8 If the step is mandatory, select Must Approve in the 
Type drop-down list.
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9 Click Apply.

Using the Print Manager
The Print Manager section of the Command Center provides
links to create maps, configure sentinels, and monitor
sentinels.

The TEKLYNX CENTRAL print manager is powered by
SENTINEL. For more information on managing sentinels, refer
to the SENTINEL Administrator’s Guide and SENTINEL User
Guide.

Configuring 
Printing for Data 
Watches

Two sentinel watches (LABELNET and Preview) are
automatically created for the browser-based printing interface
during the installation. Printers must be configured for both of
these watches.

To add or remove printers:

1 Click the Configure Data Watch link in the Print Manager 
section of the Command Center.

2 Select the LABELNET sentinel and click Properties.

3 On the Process tab, select CODESOFT Printing. Click 
Settings to launch the CODESOFT Printing Plug-in 
properties, where you can add or remove printers and 
define default settings.

4 After you have configured the printer, click OK.

5 Select the Preview sentinel and click Properties.

6 On the Default Values tab, select a printer from the 
Printer drop-down list.

7 Click OK.

Creating 
Additional Data 
Watches

Additional sentinel watches are required if you are sending
data to TEKLYNX CENTRAL at print time to trigger a print
request.

To create a sentinel watch:

1 Click the Configure Data Watch link in the Print Manager 
section of the Command Center.

Note: Data watches install automatically for the web 
printing module.
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2 Click File > New.

3 On the General tab, enter a name and group for the data 
watch. If you are sending data within a file, select the map 
you created for the file.

4 On the Input tab, select how the data input will be sent to 
TEKLYNX CENTRAL (that is, what will trigger the print 
request). If you are sending data within a file, click File 
Capture. Click Settings to define the folder where the file 
will be created to trigger the print request.

5 On the Process tab, select CODESOFT Printing. Click 
Settings to launch the CODESOFT Printing Plug-in 
properties, where you can add or remove printers and 
define default settings. On the Archiving tab of the 
CODESOFT Printing Plug-in properties, enter a username 
and password for a print user in the PrintUser group.

6 Click OK.

7 Check the Enable option in the Manager window.

Managing Printing 
Status

To activate a sentinel watch or monitor status:

1 Click the View Printing Status link in the Print Manager 
section of the Command Center.

2 To activate a watch, select the watch and select Activate 
from the SENTINEL menu.

3 To monitor print status, select Information from the 
View menu. The Information window opens. Select the 
Log tab to view print status.

Creating Map Files A map file is required if you are sending data within a file to
TEKLYNX CENTRAL at print time to trigger a print request.
Because the necessary sentinels and map files are
automatically created when TEKLYNX CENTRAL is installed,
you will only need to create map files if you have a specific
need.

To create a map file:

1 Create a sample of the data that will be sent to trigger the 
print job.
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2 Click the Create Map link in the Print Manager section of 
the Command Center.

3 Click File > New and follow the instructions in the wizard 
to create a new map file.

Using the Printing Interface
The Printing Interface section of the Command Center
provides links to configure and test the printing interface.

The TEKLYNX CENTRAL label manager is powered by
LABELNET. For more information on configuring the printing
interface, refer to the LABELNET Installation Guide.

Configuring the 
Printing Interface

To configure the printing interface:

1 Click the Configure Printing Interface link in the 
Printing Interface section of the Command Center.

The Printing Interface Configuration window opens.

Figure 3-8 Printing Interface Configuration window

2 Click Next to configure the printing interface to match 
your business needs.

The following sections offer additional detail on specific
configuration options.
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Defining Different 
Field Labels for 
Workstations

TEKLYNX CENTRAL allows you to define different field labels for
each workstation on your network.

To define field labels:

1 Click the Configure Printing Interface link in the 
Printing Interface section of the Command Center.

2 Click Next on the Printing Interface Configuration 
window.

3 Configure any necessary options on the Printing 
Interface – Options window and click Next.

4 Click on the Workstations tab on the Printing Interface 
– Data Configuration window.

Figure 3-9 Printing Interface – Data Configuration window, 
Workstations tab

5 Add any necessary workstations either by clicking Browse 
and navigating to the workstation, or by entering the 
workstation name manually. Click Add to store each 
workstation.
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6 After you have added all necessary workstations, click the 
Naming tab.

Figure 3-10 Printing Interface – Data Configuration window, 
Naming tab

7 In the Workstation dropdown list, select the workstation 
for which you want to modify the interface terminology. 
Enter the field name substitutions as needed and click 
Save to store the changes for that workstation. Repeat as 
needed for each workstation.

8 Click Next and make any other needed modifications for 
the printing interface on the following screens. Click Done 
at the end of the configuration process.

Associating Labels 
with a Product

In TEKLYNX CENTRAL, you can link labels to products to
ensure print users are printing the correct labels for each print
job.

To associate labels with a product:

1 Click the Configure Printing Interface link in the 
Printing Interface section of the Command Center.

2 Click Next on the Printing Interface Configuration 
window.

3 Configure any necessary options on the Printing 
Interface – Options window and click Next.
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4 Click the Labels tab on the Printing Interface – Data 
Configuration window.

Figure 3-11 Printing Interface – Data Configuration window, 
Labels tab

5 Select the product to which you want to link labels and 
click the Add Label button. 

The Printing Interface – Add Label window opens. 

Figure 3-12 Printing Interface – Add Label window
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6 Select the desired label in the list.

Use the empty field above the Label Name dropdown list 
to search for labels. The search results automatically 
update as you enter letters and any label names that 
contain matching text appear in the list. 

Note: Each label will only appear once in the list 
regardless of how many versions are stored in your 
system.

7 Click Add Label to store the changes.

Adding a Quantity 
Field to the 
Printing Interface

A Quantity field can be added to the printing interface so that
the print user can enter a quantity for each label loaded within
the interface.

To add the Quantity field to the printing interface:

1 Click the Configure Printing Interface link in the 
Printing Interface section of the Command Center.
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2 Click Next on the Printing Interface Configuration 
window. The Printing Interface – Options window 
opens.

Figure 3-13 Printing Interface – Options window

3 Select the Quantity of Labels check box to add the 
Quantity field to the printing interface.

4 Click Next and make any other needed modifications for 
the printing interface on the following screens. Click Done 
at the end of the configuration process.

Allowing Infinite 
Print Requests

TEKLYNX CENTRAL can be configured to continually print the
same label from a single print request, until a new print
request is sent.

To force continuous processing of the same file data until a
new file is received:

1 Click the Configure Printing Interface link in the 
Printing Interface section of the Command Center.
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2 Click Next on the Printing Interface Configuration 
window. The Printing Interface – Options window 
opens.

Figure 3-14 Printing Interface – Options window

3 Select the Infinite Print check box to force continuous 
processing until a new print request is sent.

4 Click Next and make any other needed modifications for 
the printing interface on the following screens. Click Done 
at the end of the configuration process.

Defining Common 
Variable Entry 
Settings

If multiple labels are associated with a product and the same
variable names are used across the labels, you can set up
TEKLYNX CENTRAL so that a user only enters the information
once and each common variable is updated.

To define common variable entry settings:

1 Click the Configure Printing Interface link in the 
Printing Interface section of the Command Center.

 



Chapter 3-18 Installation Guide

2 Click Next on the Printing Interface Configuration 
window. The Printing Interface – Options window 
opens.

Figure 3-15 Printing Interface – Options window

3 Select the Common Variables check box to update the 
variable on all labels for a product when the variable is 
modified in one label design.

4 Click Next and make any other needed modifications for 
the printing interface on the following screens. Click Done 
at the end of the configuration process.

Modifying Variable 
Display Settings

The administrator can hide specific form variables from user
input. The default value of these variables will be used and the
print user will not be able to modify the data in these variables.

To modify variable display settings:

1 Click the Configure Printing Interface link in the 
Printing Interface section of the Command Center.
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2 Click Next on the Printing Interface Configuration 
window. The Printing Interface – Options window 
opens.

3 Click Next to open the Printing Interface – Data 
Configuration window. Add any necessary work orders, 
products, and labels. Be sure to set the default values for 
the variables you are hiding by clicking the Change Label 
Data button on the Labels tab.

Figure 3-16 Printing Interface – Data Configuration window, 
Labels tab
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4 Click Next. The Printing Interface – Variables window 
opens.

Figure 3-17 Printing Interface – Variables window

5 Select any variables that you want to hide from the 
printing interface. Selected variables are highlighted in 
blue. 

After you’ve selected the variables, click the Delete check 
box. The variables that will not appear on the printing 
interface are highlighted in gray.

You can modify variables for additional labels by selecting 
the files in the Label dropdown list.

6 Click Next and make any other needed modifications for 
the printing interface on the following screens. Click Done 
at the end of the configuration process.

Truncating the 
Label Path in the 
Printing Interface

You can configure TEKLYNX CENTRAL so that only the label
name is displayed instead of the entire storage path. This will
help keep the directory in which the label is stored concealed
from end users.

To truncate the label path in the printing interface:

1 Click the Configure Printing Interface link in the 
Printing Interface section of the Command Center.
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2 Click Next on the Printing Interface Configuration 
window. The Printing Interface – Options window 
opens.

Figure 3-18 Printing Interface – Options window

3 Select the Truncate Label Path check box to display only 
the label name in the printing interface.

4 Click Next and make any other needed modifications for 
the printing interface on the following screens. Click Done 
at the end of the configuration process.

Displaying the 
Printer Alias in the 
Printing Interface

TEKLYNX CENTRAL can be configured to display only the
printer alias, which is assigned by the administrator when a
TEKLYNX printer driver is installed, in place of the driver name.
If this option is disabled, the driver name is displayed.

To display the printer alias in the printing interface:

1 Click the Configure Printing Interface link in the 
Printing Interface section of the Command Center.
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2 Click Next on the Printing Interface Configuration 
window. The Printing Interface – Options window 
opens.

Figure 3-19 Printing Interface – Options window

3 Select the Use Printer Alias check box to display the 
printer alias in the printing interface instead of the driver 
name.

4 Click Next and make any other needed modifications for 
the printing interface on the following screens. Click Done 
at the end of the configuration process.

Displaying the 
Form Variable 
Prompt in the 
Printing Interface

TEKLYNX CENTRAL can be configured to display the form
variable prompt in the printing interface. If this setting is
enabled, the text prompt which was configured for form
variables within CODESOFT is displayed. If this setting is
disabled, the form variable name is displayed.

To display the form variable name or prompt in the printing
interface:
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1 Click the Configure Printing Interface link in the 
Printing Interface section of the Command Center.

2 Click Next on the Printing Interface Configuration 
window. The Printing Interface – Options window 
opens.

Figure 3-20 Printing Interface – Options window

3 Select the Display Form Variable Prompt check box to 
display the form variable prompt in all places where the 
CODESOFT form variable name is typically displayed in the 
printing interface.

4 Click Next and make any other needed modifications for 
the printing interface on the following screens. Click Done 
at the end of the configuration process.

Testing the 
Printing Interface

To test the printing interface:

1 Click the Launch Printing Interface link in the Printing 
Interface section of the Command Center.
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2 Enter a user name and password for a user with print 
access from the ACPrintUser group.

3 Enter information based on your business process and 
click Print. When you click Print, any changes that you 
have made to the form variables are saved.

A message will appear stating that the print job has been 
successfully sent to the server.

Using the Printing 
Interface on a 
Mobile Device

The TEKLYNX CENTRAL printing interface is optimized for
display on mobile devices using Windows Mobile 5-6.5 and
Internet Explorer.

To use the printing interface on a mobile device:

1 In Internet Explorer on the mobile device, enter the local 
network path to the printing web page. This path is 
defined during TEKLYNX CENTRAL installation.

2 Enter a user name and password for a user with print 
access from the ACPrintUser group.

3 Enter information based on your business process and tap 
Print.

Using the Workstation Install Module
The Workstation Install section of the Command Center allows
you to remotely install the label designer application on client
workstations.

Installing 
Software on a 
Client Workstation

1 Click the Install Label Designer on Remote 
Workstation link in the Workstation Install section of the 
Command Center.
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The TEKLYNX CENTRAL Remote Installation window 
appears.

Figure 3-21 TEKLYNX CENTRAL Remote Installation window

2 Click Browse and locate the remote workstation. Select 
the client workstation in the list.

Note: The user who is attempting to install the application 
via TEKLYNX CENTRAL must be an administrator on the 
remote workstation for the installation to be successful.

3 Click Install to begin the installation.

Installing Client 
Applications from 
the DVD

You can also install the label designer and label manager
applications directly from the TEKLYNX CENTRAL DVD.

1 On the client workstation, insert the DVD and install the 
Label Designer Client application.

2 Install the Label Manager Client application from the DVD. 
During the installation process, you will be asked to select 
the LABEL ARCHIVE Server. Enter or select the name of 
the server on which TEKLYNX CENTRAL is installed.

3 Edit the CS.ini file, which is installed in C:\Documents and 
Settings\All Users\Application Data\Teklynx\CODESOFT 9. 
For Windows Vista and 2008 users, this file is located in 
C:\ProgramData\Teklynx\CODESOFT 9.

Add the line UMSSAVAILABLE=1 in the General section 
of the file.
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4 Launch CODESOFT. The application will launch in 
evaluation mode.

5 Go to Tools > Users Management. The Users 
Management window opens.

6 Select the Use User Management System (UMSS) 
option.

7 In the server address tcp://localhost:8989, replace 
localhost with the name of the server on which TEKLYNX 
CENTRAL is installed.

8 Click OK.

9 You will be prompted for a username and password. Use 
the username and password of a TEKLYNX CENTRAL 
administrator.

10 Restart CODESOFT for the changes to take effect.
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